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Welcome to VideoLink Mail!
VideoLink Mail allows you to create stunning video mail files (tapes). These files combine
audio and video so your messages have maximum impact! VideoLink Mail files are highly
compressed to keep the size small so they can be quickly sent to friends and associates and
played on any Pentium (or Pentium class) PC running Windows 95 or Windows NT 3.5x or
higher.

VideoLink Mail provides you with a virtual VCR that allows you to record and save both
audio and video from your local camera and microphone. You can then playback recordings
at a later time and watch them at your leisure.

The operation of the virtual VCR is similar to that of a standard VCR. Recordings are
referred to as 'tapes', and control over the VCR is accomplished with the buttons provided on
the display. VideoLink Mail can save tapes in two formats:

• Smith Micro video mail format—this option will save the recording without
embedding a player. This method is perfect for saving recordings for your own use, or
when saving VideoLink Mail files to send to others who have VideoLink Mail. Files
saved in this manner have a .SMV extension. Saving tapes in this format results in a
smaller file size than tapes saved in executable format. Also, these tapes can be
reloaded in VideoLink Mail, viewed from a particular place in the tape using the play
bar, or even saved in executable format at a later time.

• Executable format—this option will incorporate the VideoLink Mail player with the
recording. This method is perfect for saving video mail to send to others who do not
have VideoLink Mail. Files saved in this manner are executable files and have an
.EXE extension. These files can be run by anyone with a Pentium (or Pentium class)
PC running Windows 95 or  Windows NT 3.5x or greater.

Regardless of the method used to save files, they are electronic mail-ready and can be sent
using any PC mail utility. Files can be sent over the Internet or via on-line services such as
America Online and Prodigy.
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This guide explains how to use the program. Further information on the software can be
obtained via on-line help in VideoLink Mail.

Starting VideoLink Mail

Click the Start button and select the Programs option. Then select the VideoLink Mail
option. From the resulting popup menu, select the VideoLink Mail icon.

The VideoLink Mail Interface

VideoLink Mail provides an easy-to-use interface for accessing all of its powerful features.
The interface is divided into various components that will be discussed on the next few
pages.
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Title bar

The title bar, found at the top of the interface, provides a control-menu box you can double-
click to exit VideoLink Mail. The title bar also shows the name of the current tape, followed
by the name of the program.

Menu bar

The menu bar, found directly under the title bar, contains five menus. Each of these menus
provides a set of commands which can be used to control VideoLink Mail.



VideoLink Mail Quick Start Guide

4

Toolbar

The toolbar, found directly under the menu bar, contains buttons or "tools" that can be
clicked to access many of VideoLink Mail's most popular functions. The tools are, from left
to right:

• New — will create a new tape. If there is currently a tape in memory, you will be
asked if you wish to save the current tape.

• Open—will access the Open Tape dialog box.

• Save—will save the current tape to the specified folder.

• Send Mail—will mail the current tape as an E-mail attachment in Exchange.

• Record—will begin recording audio and video.

• Play—will play the tape that is currently in memory.

• Pause/Continue—will pause the currently playing tape. If the tape is currently
paused, when clicked, the tape will resume playing.

• Stop—will stop the currently playing tape.

• Rewind—will rewind the current tape to the beginning.

• Go to End—will forward the current tape to the end.

Mail signature field

The mail signature field displays your name so that you will be identified as the creator of a
tape. When tapes saved with the embedded player are viewed, the opening screen displays
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the name supplied in the mail signature field as the creator of the tape. You can enter your
name in the mail signature field by selecting Mail from the Setup menu.

View window

The view window displays the video from a tape which is playing, or shows the view from
the local camera when a tape is not being played.

Volume controls

The microphone volume control is located to the right of the view
window. The speaker volume control is located to the left of the
view window. Each of these controls can be adjusted by moving
the slider bar up to increase the volume or down to decrease the
volume. Hold down the left mouse button on the slider bar to move
the bar. After the bar is placed at the desired location, release the
mouse button.

Play bar

The play bar, located under the video window, represents the scope of the tape. You can use
the play bar to begin watching a tape from any selected position. Hold down the left mouse
button on the play bar to move the bar. After the bar is placed at the desired location, release
the mouse button and click the Play button. The tape will begin playing from the closest key
frame. See Playing part of a tape later in this guide for further information on key frames.
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Recording tapes
VideoLink Mail allows you to record and save video mail files (tapes) which you can send to
friends and associates. These files can be viewed by anyone with a Pentium (or Pentium
class) PC running Windows 95 or  Windows NT 3.5x or greater. Files are recorded locally
from your PC using a video camera and microphone. To record a tape:

1. Start VideoLink Mail. The main window appears.

2. Wait for your camera to initialize, and position the camera and microphone where you
would like them.

3. Click the Record button or select Record from the VCR menu. VideoLink Mail will
begin recording.

4. When you are done recording, click the Stop button or select Stop from the VCR
menu. VideoLink Mail will stop recording.

You can now review your recording, save your recording, mail your recording as an E-mail
or discard the recording.

Saving tapes
As mentioned previously in this guide, VideoLink Mail can save tapes in two different
formats:

• Smith Micro video mail format—this option will save the recording without
embedding a player. This method is perfect for saving recordings for your own use, or
when saving VideoLink Mail files to send to others who have VideoLink Mail. Files
saved in this manner have a .SMV extension. Saving tapes in this format results in a
smaller file size than tapes saved in executable format. Also, these tapes can be
reloaded in VideoLink Mail, viewed from a particular place in the tape using the play
bar, or even saved in executable format at a later time.
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• Executable format—this option will incorporate the VideoLink Mail player with the
recording. This method is perfect for saving video mail to send to others who do not
have VideoLink Mail. Files saved in this manner are executable files and have an
.EXE extension. These files can be run by anyone with a Pentium (or Pentium class)
PC running Windows 95 or  Windows NT 3.5x or greater. Saving tapes in this format
adds approximately 150k to the size of the tape.

The method used to save tapes in either format is identical. Here's how:

1. Record a tape. See Recording Tapes earlier in this guide for further information.

2. Click the Save button or select Save as from the File menu. The Save Tape dialog box
appears.

3. Enter a name for the tape in the File name field.

4. Select the desired tape format in the Save as type drop-down list.

5. Click OK to save the tape.

Playing tapes
While VideoLink Mail tapes which have been saved with the embedded player can be played
by anyone with a Pentium (or Pentium class) PC running Windows 95 or  Windows NT
3.5x or greater, tapes which have been saved in Smith Micro video mail format can only be
played from within VideoLink Mail. It is recommended that tapes which are created for
personal use be saved in Smith Micro video mail format, as these tapes will take up less hard
drive space. To play tapes:

1. Start VideoLink Mail. The main window appears.

2. Click the Open button or select Open from the File menu. The Open Tape dialog box
appears.

3. Select the desired tape and click Open.
4. The selected tape will begin playing in the video window.
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Note: to play a tape that is already in memory, click the Play button or select Play from the
VCR menu.

Playing part of a tape

You can use the play bar to move to any part of a tape, and begin watching the tape from
that point. After the play bar slider is placed at the desired location, click the Play button.
The tape will begin playing from the closest key frame.

A key frame is a frame with a "marker". You can specify how often key frames are recorded
from the Recording Rate dialog box, accessed from the Video option from the Setup menu.

If you increase the number of key frames in the tape, you can increase your control over
where you begin playing the tape. However, increasing the number of key frames in the tape
will also increase the size of the tape. If size is a primary concern, reduce the number of key
frames by increasing the number of normal frames between key frames.

Mailing tapes
VideoLink Mail records audio and video in formats that can easily be sent via electronic
mail (E-mail). It uses special digital compression techniques to keep the size of the tapes as
small as possible. The digital audio in recorded in a tape is compressed almost 20 times
smaller than its original size. The video is compressed over 200 times smaller than its
original size. The following two sections describe how to send these tapes in E-mail
messages.

Mailing tapes automatically through Exchange

If you are using Microsoft Exchange, VideoLink Mail can automatically open Exchange and
create a new message with the current tape attached to the message. The tape will
automatically be converted to executable format when attached to an E-mail in this manner.
All you need to do is address the message to the desired recipient(s) and click Send. Here's
how to automatically send tapes through Exchange:
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1. Start VideoLink Mail The main window appears.

2. Record or open the desired tape.

3. Click the Mail button or select Send mail from the File menu. The Choose Profile
dialog box appears.

4. Select the desired Exchange profile from the drop-down list and click OK.

5. A New Message dialog box appears. The Subject field will read "VMail message", and
the current tape will be attached as an .EXE file to the message.

6. Address the message to the desired recipients. If you are unsure how to perform this
step, consult your Microsoft Exchange documentation.

7. Click Send to send the message via Exchange.

Note: You must have Microsoft Exchange installed and properly configured to
automatically send E-mail messages in this manner. If you do not have Exchange installed,
or send E-mail via another method, see Mailing tapes manually for further information.

Mailing tapes manually

If you are not using Microsoft Exchange, or sometimes use a program other than  Exchange
to send E-mail, you can still easily attach tapes to your E-mail messages. Sending tapes
through E-mail requires that your on-line service or Internet Service Provider (ISP) allows
file attachments. All you need to do is create an E-mail message to the desired recipient(s),
attach the video mail file and send the E-mail. The specific steps necessary to access your E-
mail account will vary, but the following guidelines should apply for most services. If you
have not

1. Start VideoLink Mail. The main window appears.

2. Record or open the desired tape.
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• If the intended recipient(s) has VideoLink Mail, save the tape as a Smith Micro
video mail file.

• If the intended recipient(s) does not have VideoLink Mail, save the tape as an
executable file.

3. Open your E-mail program. (For example, you may use America Online, Eudora,
Netscape, Internet Explorer or a host of others).

4. Select the option that allows you to create a new E-mail message.

5. Select the option that allows you to attach files to your message, and attach the desired
video mail file.

6. Address the message to the desired recipients. If you are unsure how to perform this
step, consult your E-mail program's documentation.

7. Perform the necessary steps to send the message.

Note: Some E-mail applications, such as Juno, do not support attachments. If your E-mail
service does not support attachments, you will be unable to send video mail files via E-mail.

Further information
Further information on the topics described in this guide are available in the VideoLink Mail
on-line help. The on-line help is accessed from the Help menu in the VideoLink Mail
program. The following sections of this guide describe the available configuration options.

Hardware setup
The Hardware Setup dialog allows you to specify the codec that VideoLink Mail will use to
compress audio when recording tapes. You can also access your video device's setup options.
It is recommended that you do not modify these setting unless you have compelling reasons
to change them. To access the Hardware Setup dialog box:
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1. Start VideoLink Mail. The main window appears.

2. Select the Hardware option in the Setup menu. The Hardware Setup dialog box
shown below appears:

3.  Select the desired audio codec from the drop-down list.

4.  Select the video input device from the drop-down list.

5.  Click OK to save your changes, or Cancel to discard your changes.

The following text describes the options available in the Hardware Setup dialog box.

Audio Compression Mode

Select the desired compression mode from the provided drop-down list. Note: If No audio is
selected, the Play and the Record options will be disabled.
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Video Capture

Select the desired video input device from the provided drop-down list.

• Mirror video — when selected, the image displayed in the view window appears as it
would if you were in front of a mirror.

• Invert video — when selected, the image displayed in the view window appears
inverted.

Video Manufacturer's Setup Dialog

Click these buttons to access the Video For Windows setup dialogs for your video hardware
drivers. Most video hardware devices offer three setup dialogs, Source, Format and
Display. Consult your video hardware documentation for information on the contents of
these dialogs. Note: All options may not be available for all video hardware devices.

VCR fine tuning
The Fine Tuning dialog box allows you to optimize the video settings to your personal
preferences. To specify the desired video settings:

1. Start VideoLink Mail. The main window appears.

2. Select Fine tune Video under the Setup menu. The Fine Tuning dialog box shown
below appears:
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3.  Adjust the slider bars in the provided fields.

4.  Click OK to save your changes, or Cancel to discard your changes. Press Defaults to
return all fields to their default value.

The following text describes each of the options available in the VCR Fine Tune dialog box.

Frame Rate/Quality Trade-off

This slider control allows you to select the trade-off between speed and picture quality which
will be used by VideoLink Mail. As the slider is moved towards a sharper picture, the more
data must be recorded, which will result in a larger file size for the tape.
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Motion Sensitivity

This setting controls the sensitivity level of the camera being used by VideoLink Mail.
Sometimes cameras can generate “visual noise” in a picture. This can be seen by taking your
camera and pointing it at a perfectly blank, white wall and studying the image it produces.
Typically, you will see “boiling” or some kind of movement or motion in the picture, even if
there is no real motion. This visual noise translates into data being recorded that relates only
to the visual noise, and therefore cuts down on your picture speed.

By decreasing the sensitivity, you can cut down on the effects of this visual noise. All
cameras produce some level of noise, so the filter is usually not all the way on the “low” end.
If the setting is too far towards “high” sensitivity, you will see the image “smear” as things
move across the screen--almost as if part of the image moves and part of the image stays still.
In this case the sensitivity is set so high that it is actually ignoring real motion, rather than
just camera noise.

You will need to find a point where the image seems to be cleanest and produces the best
frame rate.  For most cameras, this is about 1/4 to 1/3 of the way towards high sensitivity.

Recording rate
VideoLink allows you to limit the amount of information stored when recording a tape and
specify how often key frames are recorded. To specify your recording rate preferences:

1. Start VideoLink Mail. The main window appears.

2. Select Record rate under the Setup menu. The Record Rate dialog box shown below:
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3.  Adjust the desired values in the provided fields.

4.  Click OK to save your changes, or Cancel to discard your changes. Press Defaults to
return all fields to their default value.

The following text describes each of the options available in the Recording Rate dialog box.

Recording rate
These options allow you to limit the amount of information stored when recording a tape.
Lowering the recording rate will reduce the size of the video mail file. Note that this will also
reduce the frame rate of the recording, and make the video "choppier". That is because fewer
frames will be recorded. Available options are:

• 19.2 K — the recording rate will be at 19,200 bytes per second.

• 28.8 K — the recording rate will be at 28,800 bytes per second.

• 56.6 K — the recording rate will be at 56,600 bytes per second.

• 128 K — the recording rate will be at 128,000 bytes per second.

• Unlimited — the recording rate will go at the fastest possible speed.

Record a key frame every



VideoLink Mail Quick Start Guide

16

This option will specify how often VideoLink Mail will record a key frame. Set this option
to a lower number to increase the number of key frames that are recorded. This will increase
your control over scrolling through the tape; however, it will also increase the size of the
video mail file.

• n frames — Click the provided arrows or enter the desired value to specify how often
key frames will be recorded.

Mail setup
The Mail Setup dialog box allows you to specify your mail signature and whether you wish
to keep a local copy of mailed tapes. To access the Mail Setup dialog box:

1. Start VideoLink Mail. The main window appears.

2. Select the Mail option under the Setup menu. The Mail Setup dialog box shown on the
next page appears:

3.  Make the desired changes in the provided fields.

4.  Click OK to save your changes, or Cancel to discard your changes.

The following text describes each of the options available in the Mail Setup dialog box.

Mail signature
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Enter your name in this field. The mail signature field identifies who created a tape. When a
tape is saved in executable player format, a brief opening screen appears. The opening screen
displays the displays the name supplied in this field as the creator of the tape.

Keep local copies of mailed EXE tapes

Place a check mark in this field if you wish to keep a copy of tapes sent using the automatic
mail feature. See Mailing tape automatically through Exchange earlier in this guide for
further information.
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